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Flight Map 
Making Your Flight Map (Before the Flight!) 

 
You will need to prepare a flight map using ArcGIS 9x before your surveillance flights. This map will 
then be exported and transferred to the navigation equipment in the plane. There are two methods of 
preparing your flight map. Either use the pre-made data and map or create your own map using data 
available at your station. 
 

1. Using the pre-made data and flight map for ND or SD. 
a. This Pre-made map includes USFWS easements, WPA’s, NWR’s, Roads, Cultural 

Points, Ponds & Lakes, Counties, Violations layer with drop down pick lists for 
violation type and flight lines. 

b. If you haven’t done so already, download the data from the web at: 
http://www.fws.gov.gov/devilslake/Flights/ or request a CD copy from 
Scott_Ralston@fws.gov 

c. If you downloaded it then unzip the file and store it on your computer or network or if 
you received the CD, then copy the CD contents to your computer or network. 

d. Open the file named NDFlightMap.mxd or SDFlightMap.mxd in ArcGIS 9 
e. Zoom to the area that you will be flying (your district). Make sure the entire flight area 

is visible on screen because only what you see will be exported to the final map 
f. If there is specific data you need in your map that is not included in the pre-made map 

data you can add it. 
g. If the symbology or other data properties do not suite your needs you can also change 

them. 
h. Optionally, use the editing function to edit the Flight Lines layer.  

i. This can be used if you have specific flight paths you want to follow. Most often 
you would draw a flight path that runs the full length of your flight area (N-S or 
E-W alternating by year) and would run every other mile (2 miles between flight 
lines to observe a mile out each side of the plane).  

ii. By editing the attributes for those flight lines you can number and label them 
accordingly such as if you want to keep track of where you have been. 
(Example: “We flew flight lines 15-24 today so tomorrow you can do 25-48”) 

iii. In the Pre-made data there are 2 sets of flight lines. The first is for observation 
flights and the second is for photography flights. For those that combine the two 
flights you will only use one of the flight lines layers. 

i. If the ArcPad toolbar is not visible you can turn it on under the menu: 
View>Toolbars>ArcPad 

j. Once the map is the way you want it you must export the map to an ArcPad Project to 
be used on the laptops in the plane. 

i. The export or “Check out” command will dump all the files in your view into a 
new folder and will also create an ArcPad map file (*.apm) that you will open in 
ArcPad and your map will appear the same as it was in ArcGIS.  

ii. Any files that come from a “Geodatabase” such as the pre-made violations 
points layer will also be able to be “Checked In”. This means you check out the 
data, conduct your surveys and when done you check the data in which will 
automatically merge any new information into the original dataset in ArcGIS. 
This works great for multiple observers using different laptops. 
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k. First press the “Get Data For ArcPad” Button  
l. Select all the layers you want to export.  

(Basically select everything except the second flight lines) 

 
m. Next select the layers you want to be able to merge back in with the original dataset 

after your flight. Only geodatabase layers will be available for Check In. 
(Normaly just the Violations points layer unless you plan on making changes to the 
flight lines during the flight then check that as well) 

 
n. Select the location you want all the exported files to be placed and give it a Unique 

name. This will create a folder with all your GIS layers stored in at the place you 
specify with the folder name you specify. Each time you do a checkout the folder name 
must be unique because when you go to check in the data, if you have multiple check 
in’s with the same name, only the first one will be able to be checked back in. The 
others with the same name will NOT check in. For this reason if you will have more 
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than one observer (thus working on more than one laptop in the plane) you must do a 
separate checkout for each laptop. Once the data is checked in you need to create a new 
Checkout before collecting more data because you will not be able to check in the same 
data twice. 

 
o. Once the checkout is finished you should get a confirmation screen. Check that the total 

layers equals the total number succeeded. 

 
p. Make sure to SAVE YOUR MAP in ArcGIS. If you do not save the program will not 

keep a record of your Check Out and will not be able to check it back in. 
q. You now need to copy your data to a CD, DVD or USB Flash drive to transfer it to the 

laptop in the plane. A USB Flash drive is the best method of transfer and you should 
have a minimum of ½ a Gigabyte (512MB) of storage space. A 2 gigabyte flash drive 
would be optimal for transferring both maps and aerial photos you may take during your 
flight. This is the recommended drive 
http://www.cdwg.com/shop/products/default.aspx?EDC=956607 

r. Leave a copy of your Check Out folder in its original location on the computer from 
which you checked out from.  

2. Using your own Data and Maps.  
a. If you have your own GIS data and want to create your own custom flight map, use 

ArcGIS to create your layout the way you want it.  
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b. Recommended layers are: USFWS easements, WPA’s, NWR’s, Roads, Cultural Points, 
(houses, farms, etc) Ponds & Lakes, Counties, Violations layer with drop down pick 
lists for violation type and flight lines.  

c. You can load aerial photos but it is not recommended for several reasons: 
i. It requires more storage space and you may be limited in size you can transfer 

on your media such as a CD can only hold 700MB 
ii. These larger image files will be slower to redraw when your map refreshed as 

you travel 
iii. Experience and test runs have shown aerial photos provide too much detail and 

observers spend more time comparing features on screen to what they see out 
the window. Example: instead of just confirming that the farmstead you see out 
your window is the same one you see on your screen represented by just a 
cultural point dot, you may, with the aerial photo, try to count the number of 
grain bins on the property to be sure of what you see and start questioning 
yourself if items don’t match exactly.  

d. You will need to create a new layer to mark violations with. A geodatabase feature class 
file is recommended over a standard shapefile because you can use the check in option 
and also create dropdown pick lists for violation type to save yourself time when 
marking violations in flight. You can either copy the geodatabase from the pre-made 
data mentioned above or create a new one 

e. To create a Geodatabase and new feature class: 
i. Open ArcCatalog and navigate to the location you want to store the new file. 

ii. Right Click and Choose New>Personal Geodatabase and name it whatever you 
want 

 
iii. Right Click on the new geodatabase and choose properties 
iv. Under the Domain tab fill in a field name under the Domain Name Colum such 

as “Violation Type” 
v. Under “Domain Properties” and “Field Type” choose “Text” 
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vi. Under Coded Values fill in a code and a description. The description can be the 
same as the code or different but keep it short. These coded values will be the 
items in the drop down list for Violation Type when you mark a new point.  

 
vii. Hit OK when done 

viii. Double Click on the new geodatabase to open it then right click and choose 
New>Feature Class. A feature class is synonymous to a shapefile but is just 
located within a geodatabase 

 
ix. Give the feature class a name such as “Violations” and hit Next 
x. Leave the storage configuration as default and hit next 

xi. Highlight “Geometry” under “Data Type” (see screen-shot below) 
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xii. In “Field Properties” and “Geometry Type” choose “Point” 

 
xiii. Under “Spatial Reference” click the box with 3 dots … 

1. Before doing this you may need to find or create a shapefile from 
existing data that includes your flight area such as district counties or 
even the whole state and make sure that shapefile has a coordinate 
system defined appropriate to your area such as NAD 1983, Zone 14N 
for the east half of ND & SD (should be the same coordinate system for 
all layer in map). If you already have this type of file then continue on.  

xiv. In the Spatial Reference screen, choose “Import” and point to a shapefile or 
feature class on your computer that covers your entire flight area as mentioned 
above. Then Click OK. This step is very important because it defines the area 
that you can draw points in within the map. If no spatial reference is defined or 
the wrong area is defined, when you try to place a point on your map you will 
get an error saying “Coordinates are out of bounds” and will not place the point. 
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xv. Create a new field by clicking in the blank space below “SHAPE” and type in a 
name such as “Type” and under “Data Type” Choose Text 

xvi. Under “Field Properties” and “Domain” choose “Violation Type” or whatever 
you named your domain in the Geodatabase earlier. This now linked the drop 
down list you created earlier to this field in the attribute table 

 
xvii. You may also wan to create a new field called “Notes” with type being text and 

length being 100. This will give you a place to type additional notes about a 
violation point if you wish 

xviii. Some may also want to make a field name “Observer” if you want to keep track 
of who recorded the violation. 

xix. Click finish when done setting up this feature class and add it to your map. 
xx. Create any other editable layers in the same way such as creating a line type 

feature class to draw out your flight lines. 
f. Once your custom map is created, zoom so you can see the whole map in your window 
g. Follow the steps (1i-1r) outlined above for exporting your map to ArcPad and the 

laptops on the plane.  
 

IMPORTANT: if using ArcGIS/ArcMap  
on the Tablet Laptop! 

 
 ArcGIS has software security features. If you need to use ArcGIS/ArcMap on the tablet laptop 
you will need to PLUG IN THE YELLOW USB SENTINEL KEY BEFORE YOU STARTUP THE 
COMPUTER. Without the key plugged in the program will not run. The key should be in the laptop 
carrying case. Each key is specific to that computer and will not work in other computers so do not 
exchange between laptops. This key is not needed to run ArcPad or any other features on the laptop 
except ArcGIS which includes ArcMap and ArcCatalog.  
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Tablet Laptop Basics 
 

The laptops used with the plane are designed to have the mobile processing power needed for 
any GIS applications and the convertible tablet provides a reduction in dexterity issues often found 
with mouse touch pads. These laptops also include wireless connectivity for the GPS units and 
CD/DVD burners for transferring data.  

1. The laptop can be used as a standard style laptop with the keyboard and mouse pad.  
2. Alternatively you can turn the screen (counter clockwise – follow the arrow on the 

hinge) and lay it flat to use as a tablet.  
3. The screen is only touch sensitive to the stylus pen provided with the unit. Do not touch 

the screen with any other hard object that may scratch the screen. Resting your hand on 
the screen is fine and will not affect your mouse/cursor. The stylus is located on the 
front left side of the computer and can be released using the switch on the bottom left 
side of the unit, below the pen. 

4. Having the pen near the screen will move the mouse around 
5. Tapping the screen serves as a left click of a mouse.  
6. Tap and drag works the same as a left click and drag 
7. Press and hold on the screen until an icon appears then release will serve as a right 

click. You can also hold the button down on the side of the pen and tap the screen once 
which will also serve as a right click 

8. The orientation of the screen can be changed so you can hold the tablet in different 
positions to suit your needs. Press the first (most left-hand) button on the bottom of the 
screen to rotate. Notice when using the software associated with the photography 
equipment the screen must be in a landscape mode. You will get an error about screen 
resolution if the screen is in a portrait orientation. When just using ArcPad for 
navigation the orientation does not matter. 
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9. Without the keyboard in tablet mode you will use the handwriting options instead of 
typing test. When your cursor/stylus is in a text box or anywhere text can be placed a 
little keyboard icon will appear. 

 
10. Tap the icon and a writing window will appear. You can write in this window and it will 

automatically recognize the text. The letter recognition works fairly well and should 
recognize cursive but to reduce errors I recommend printing as clearly as possible. 
When you have written what you want or if you run out of room in the window hit the 
“Insert” button to insert the text into the text box or document your are working in. If 
you prefer a keyboard style you can hit the keyboard button located at the bottom left 
side of the writing window and tap keys to type. 

 
11. When using the stylus it is recommended to watch the cursor not the tip of the pen 

because sometimes they don’t line up perfect. However if the stylus is poorly aligned 
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with the cursor you can calibrate it by double clicking on the tablet setting icon located 
next to the clock and choose calibrate. Follow on screen directions.  

 
12. The laptop is also equipped with a CD and DVD burner. If you need to transfer data 

from the computer, insert a blank disk and if “Nero SmartStart” does not start 
automatically you can open the program from the desktop. Choose the Data Icon (looks 
like a piece of paper) and “Make a Data CD”. Follow the on screen directions to add 
your data to the disk and finish the burning process. A CD will hold 700MB and a DVD 
will hold 4.7 Gigabytes. If you have an extreme amount of data you can purchase a dual 
layer DVD which will hold about 9Gigabytes or just burn on multiple disks.  

 
13. Instead of having a computer and a notepad on your lap you can also take notes on the 

computer if needed. Either open Microsoft word and use the handwriting recognition as 
described above or use “Windows Journal” 
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a. Windows journal can be opened either on the desktop or hit the Journal button 
on the screen. 

 
b. Windows journal looks like a piece of paper and you draw on it the same as you 

would a piece of paper. It does not recognize handwriting but simply saves what 
you scribble down. You can also draw sketches or whatever else you need.  

 
c. Don’t forget to save your journal document and transfer it along with any of 

your other files when you leave the plane. You can also choose print and print to 
the Adobe Acrobat Distiller which will make a pdf document out of your journal 
entry, then you can save that with the rest of your data. 

d. If you don’t already have it on your office computer you will have to download 
and install Windows Journal Viewer to view the journal you created on the 
tablet. Go to Microsoft.com and search for Windows Journal Viewer and you 
can download and install it for free. 

e. Aside from the navigation and camera software that will be described later the 
tablet laptop for the plane also has Adobe Photoshop, ArcGIS and Microsoft 
Office 
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GPS 
 

The GPS units in the plane use a wireless technology called Bluetooth. Bluetooth is simply a 
short range wireless connection between your computer and the GPS unit. Bluetooth is only a one-on-
one communication so for each laptop or PDA used you must have an associated GPS unit.  
 

1. Make sure the batteries are charged before use with the battery charger provided. The unit can 
be charged while running if needed and has both an outlet adapter and a 12Volt adapter as well 
as can be charged from the USB port on the computer. The batteries should last for about 10 
hours on a full charge. 

2. There are 2 styles of GPS units but the both work the same.  
3. With the silver unit the On-Off switch and power plug port is located on the side 
4. With the Black unit the power button is the white plastic button on the top which you need to 

hold down for a few seconds to turn on or off.  
5. On both units the blue light will blink when it is connected to your computer and the Orange or 

green light will blink when it has a satellite position fix. 
6. To connect to your computer, turn the GPS and the computer on. 
7. On the Desktop, Double click the “My Bluetooth Places Icon” 
8. If Bluetooth GPS Units you are using match the shortcut icons listed (Property numbers) 

double click one to connect.  
9. If the Bluetooth GPS you need to connect to is not listed, double click the “Find Bluetooth 

Devices” and then double click to connect to one once found. If there are multiple devices 
listed and you are not sure which one is right use trial and error to attempt to connect to each 
one in the list until the a connection is found.  

10. While connecting to either unit your computer may ask for a pass key or security key. A 
notification bubble will pop up near the clock which you click/tap on to enter the key code. The 
Key for any grey unit is “6268” for any of the black units it will be “0000”. 
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11. If you are running more than one laptop and GPS, you may get an error message saying you 
can not connect to the device if one of the other laptops has already connected to that GPS unit. 
Just cancel and connect to a different GPS listed in your available connections.  

 

 
 

12. Once connected it should list your connection and COM Port Number. Usually it will be 
COM5 but if it is different, remember it so you can set ArcPad to look for the GPS in the 
correct location. 
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ArcPad Navigation During  
Observation Flights 

 
It is highly recommended that before using ArcPad in the plane that you practice using the 

basic features of ArcPad in your office. ArcPad 7 is a fairly simple user interface and is easy to 
learn but you should be familiar before surveying in the plane. ArcPad 7 can be installed on your 
desktop or laptop computer. It is also used on Trimble GeoXT GPS units where you could practice 
using it with a GPS. Major things to know are opening maps, enabling a GPS, toggling on or off 
layers if needed or changing the color or symbology of layers as needed, standard navigation such 
as pan and zoom, editing a layer, placing points and populating a field in the attribute table. For 
more general information on using ArcPad 7 and specifically with a Trimble GPS see the tutorial 
http://www.fws.gov/devilslake/Storage/Trimble_GeoXT_with_ArcPad7.pdf  

 
1. If you will be conducting a short flight and the laptop battery is full you don’t have to plug it in. 

A fully charged battery should last at least 3 to 4 hours. However if you are doing a longer 
flight, plug the laptop in using the provided power cord and the power inverter in the plane. 
The computer performance will be a little faster when plugged in. Caution: DO NOT leave the 
power inverter plugged in or running if the plane’s engine is not running. Aircraft batteries are 
light duty and will easily die without the alternator recharging it! 

2. Transfer the folder containing the flight maps that you created to the desktop of the computer. 
3. Make sure the GPS is connected as described above using the “My Bluetooth Places” 
4. Open ArcPad 7 by clicking on the ArcPad icon on your desktop or in the start menu. 

 
5. Use the custom toolbar with oversized buttons for most tasks you will perform. The button 

order will also remind you of the setups to using your map from left to right. 

 
6. Hit the folder icon to open your map from the location you saved to onto the computer 

(Desktop)  

7. Hit the GPS button to activate the GPS in AcPad. If you have a signal a target should 

appear on screen at the location you are at.  
a. If the GPS is not working: 
b. Check that the GPS unit is on. 
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c. Check that the “My Bluetooth Places” shows that you are connected to the GPS serial 
port. And the Bluetooth icon by your clock is blue with a green center instead of a white 
center. This means it is connected. If not then reconnect. 

d. If it is connected to the computer fine (Bluetooth works) but ArcPad can’t find the 
signal then check GPS Preferences by hitting the drop down arrow next to the GPS Icon 

 
e. The Protocol should be NMEA, The port should be COM5 Bluetooth unless when you 

connected to the Bluetooth serial port it said a different COM number, Baud should be 
4800 

 
f. If the GPS is connected to your computer fine and it is just a poor reception problem try 

repositioning the GPS unit in the dash of the airplane to get the most possible access to 
the sky. Often the signal will come back shortly as the aircraft moves in location. 

8. Your map should appear approximately the same as it was on your ArcGIS screen. If you need 
to make any changes such as turning certain layers on or off or changing the colors or 

symbology then do that now. The layers can be accessed by hitting the layer properties icon  
 
9. This will bring up the table of contents where you can toggle on or off certain layers or change 

the legend properties if needed 
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10. You may want to setup a GPS Tracklog to keep track of where you have flown. If so, double 

click/tap the “GPS Tracklog” in the table of contents. The track log will be a shapefile with a 
point taken at every time interval you specify. Choose where to save the shapefile to 
(preferably in the same folder as the rest of your data so you will remember to take it with you 
when you leave the plane. Also set the time interval. Every 20-30 seconds is sufficient unless 
you want higher detail of your flight path. Hit OK when done. You can choose whether you 
want the track log to be visible on screen or not in the table of contents window. 

 
11. The Tracklog can be turned on or off by hitting the GPS Tracklog option in the dropdown list 

next to the Satellite Icon. 

12. Use the navigation tools to zoom to the scale you want for your map.  
A good scale to start with is approximately 1:30,000. Scale is displayed in the status bar on the 
bottom right side of the window. 

13. Turn on the Automatic Map Rotation so direction of travel will be up on the screen.  
a. IMPORTANT!: Before turning on the rotation make sure your map scale is the size you 

want it. The rotation tool sent with ArcPad has a bug in the program that causes the map 
to zoom out every time it rotates. A patch was programmed into the custom toolbar that 
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will keep your map scale the same. However in order for this patch to work it is set to 
save the map scale that was set when the rotation is turned on and will reset to this 
saved value if the scale changes. Therefore you will not be able to zoom in or out while 
the rotation is on.  

i. If you need to change scales, turn off the rotation, zoom to the new scale and 
turn the rotation back on. 

b. Without the rotation tool you may be disoriented if North is always up.  
c. Use the map rotation button on the custom oversized toolbar NOT the rotation tool built 

into ArcPad 7. This is a custom version of the tool that will refresh faster than the built 
in version and give you options to change settings.  

d. When you hit the Rotation button a dialog box will pop up to change any settings. 
Default settings are fine. The only setting some may want to change is how often the 
screen refreshes. If you are changing direction often you may want a faster.  

e. Hit OK when done with the settings NOT the X and the map should begin to rotate as 
long as you have a GPS fix. 

f. If you need to turn off the rotation (Such as to zoom in or out) hit the Stop Rotation 
button 

g. You can also toggle the North Arrow on which will place an arrow on your map 
pointing North to help orient yourself. 

 
14. At this point the navigation with ArcPad should be working. You can prepare to collect data 

points by starting editing mode. 
15. Press the drop down arrow next to the pencil icon and choose the layer from that list that you 

want to edit such as the “Violations” layer. 
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16. The editor toolbar will appear but unless you need a specific task you can ignore that toolbar 
because the basic tools you need are on the oversized custom toolbar 

17. To mark a point: 
a. Make sure the point icon is highlighted 

 
b. Identify the location on the map that coincides with the land feature you see out the 

window of your airplane.  
c. Tap on the screen where you want to mark your point. Mark at least within the 

appropriate quarter section and if possible within the ¼ of the ¼. Marking the correct 
location is important because this is the point you will fly over to take the aerial photo. 
If a violation covers more than 1 quarter section, place a point in each of the affected 
quarters.  

d. Once you mark the location a red star (or whatever symbol you designated) will appear 
on your map and a window will pop up to populate any fields you created for your 
points. Choose the violation type from the drop down list. 

 
e. If you have time or a reason you can fill in any additional comments or notes or any 

other fields that you have created. 
f. When finished with that point, hit OK. DO NOT HIT THE X BUTTON to close. The X 

will close the window and NOT save your point. 
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18. To modify any of the points you have taken: 
a. First select it (click on it) with the selection tool (Black cursor icon) and a dotted box 

will appear around it. The last point you took should already be selected so you don’t 
have to re-select it if that is the point you want to modify 

b. To delete it press the red X on the toolbar 
c. To Change the attributes such as the violation type or add or remove notes and 

comments, hit the Properties button on the toolbar (box with hand pointing) 

 
19. When you are done with your flight, stop editing and save your edits by hitting the pencil icon 

so it is un-highlighted  
20. Save your map by hitting the disk icon, then close ArcPad. Close ArcPad before copying files 

or you may get an error stating the file can not be copied because it is still in use. 
21. Transfer your files From the laptop back to your office using either a USB flash drive or burn a 

CD or DVD (you must provide your own blank disks) using the NERO burner software on the 
computer (Choose Data disk option and follow on screen directions). Do this for all the laptops 
used during your flight to collect information.  

22. If you are conducting photography flights see the section below called “Preparing for 
Photography Flights” and “Performing Photography Flights”. 

23. Be courteous to the next user and or the pilot by: 
a. Delete any maps, journal or note files, photographs or any other data you put on any of 

the laptop computers after you have saved it to your own disk and remove all disks from 
the drive. 

b. Return the stylus pen to the port in the front side of the laptop. 
c. Wipe any grease or smudges from the tablet screen using the blue cloth provided in the 

laptop case. 
d. Shutdown the laptops and turn the screen so the writing side is facing down 
e. Inform the pilot of any batteries that need to be charged such as GPS batteries or if you 

ran the laptop on battery power. 
f. Put the equipment away in their appropriate places. Laptops have their own carrying 

cases in which the laptop, its cords and one GPS unit with power cords go in the laptop 
case.  
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Using the data after your flight 
 
1. Upon returning to the office with your data, copy the flight map folder back to the original 

computer location it came from. When asked if you want to overwrite the old information 
choose Yes. 

2. Open ArcMap and the original flight map you had exported from.  
3. Make sure the ArcPad toolbar is visible. If not then turn it on from the View>Toolbars menu 

4. From the Editor toolbar (or the x-tools start editing button ) start editing the Violations 
geodatabase file (or whatever you named your points file). 

5. Once in editing mode the “Check in Data from ArcPad” button should light up. Press that 
button. 

 
6. Check the boxes next to the data you want to check in. If you checked out more than one set of 

data (i.e. to multiple laptops) all checked out geodatabase files will be displayed. Therefore 
only select items with the “Check Out Name” column appropriate to the folders that you know 
are ready to be checked in. You can check in multiple sessions at once but be careful not to 
check in data that is not ready yet (information from a laptop that has not been copied back to 
it’s original location) because once you check in the data you can not check in the same folder 
again.  

7. If you accidentally checked in data that wasn’t ready yet, failed to save the map when you 
check out, checked out only 1 set of data but used it on multiple laptops or for any other reason 
you have data checked out but it won’t let you check it back in, refer to the “Troubleshooting 
Data Check In” section.  

8. Once the necessary layers are selected hit “Check in” 
9. After the check in is complete stop your editing session and save your edits. 
10. Repeat this for all checked out data. You can check in your work at the end of each day (and 

then check out a new session for the next day if you are doing a multiple day survey) or keep 
collecting data on the checked out map until you complete your flights, then do one check in at 
the end.  

11. When you check in you should notice that any new points gathered during your flights will be 
merged into the original data so if you check in a session from each of two laptops the 
information from both will appear in the flight map. 

12. If you used the track log option the Tracklog shapefile was created in ArcPad, thus not part of 
the original data and therefore will not be checked in with the rest of your data. You will have 
to copy that data from the checkout folder (or other location if you stored it outside the original 
folder), store it where ever you want on your computer, then add it to your map. You can merge 
multiple Tracklog files together using ArcToolbox>Data Management Tools>General>Merge 
or Append (Merge combines 2 or more files in a NEW file, Append combines 1 or more files 
into an EXISTING file). 

13. Once you have checked in your data and copied any other miscellaneous files you needed from 
that folder you can delete the checkout folder. Don’t forget to save any journal or note files that 
you may have placed into that data folder from the laptop! 
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14. For all the violation points you have recorded you can easily obtain the easement information 
on which the violation occurred and have that information show up in the attribute table for 
each point.  

a. In ArcMap or ArcCatalog open ArcToolbox  
b. Navigate to Analysis Tools>Overlay and double click on Identity 
c. For “Input Features” choose the point layers used to collect all your violations 
d. For “Identity Features” choose your easements layer 
e. Under Output Feature Class choose a location and filename for the shapefile or 

geodatabase feature class that will be formed from the identity. 
f. Press OK 
g. The result will be a new file with all your points that will look identical to the original 

point file. However if you open the attribute table you will see each point contains the 
fields that were originally in the point such as violation type, but will also contain all 
the attributes from the easement that it coincided with such as tract number. Using x-
tools extension you can export your attribute table to excel and format and print it if you 
wan t a hardcopy list. 

h. You can also use this intersect tool with the PLS sections layer to obtain legal 
descriptions of the violation points. 

i. If there are any fields that were imported during the Identity process that you do not 
what cluttering up the attribute table simply open the attribute table for your points layer 
and right click on the column heading of the field you wan to remove and hit Delete 
Field. 
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Preparing Maps for Photography Flights 
 

One method of conducting easement violation flights is to have a first flight (observation flight) as 
described above where you will record the location of all violations. Once all violations have been 
recorded you will conduct a second flight to photograph all your violations. In some situations only 
one flight will be conducted where violations found and are immediately photographed. For this 
scenario refer to the section below called “Combining Observation and Photography Flights” 

 
1. In preparation for your photography flight you must first have points captured using the 

methods described above.  
2. Open your flight map in ArcMap as you had in the initial flight map creation process. You will 

once again create a similar map but the flight path will connect your violation points. 
3. If you are using the pre-made data and maps you can use the FlightLine2 feature class file 

already made. If you are creating your own data you will have to create a new shapefile or 
feature class. Follow the directions used above for creating the point file but under shape type 
or shape geometry choose line or polyline instead of point. The only field necessary for this file 
is optionally a label field or something to specify information about the flight such as 
photographer for that portion of the flight path. 

4. Start editing the FlightLines2 layer. 
5. Draw a path that connects all the violation points on your map. Keep in mind a few things as 

you draw your flight path. 
a. You will be taking belly mount pictures vertical with the ground so there will be only 

one flight over the target then move to the next location. No circling around the target. 
b. The target image size is a ¼ section with a little overlap so design your flight path to 

photograph the entire quarter section that the point is marked in. 
c. Attempt to approach and over fly your target in a cardinal direction. This will make 

orientation of the photo later on easier and will maximize the frame since most land 
boundaries are laid out in cardinal directions. 

d. Remember the planes performance characteristics and the speed you will be traveling 
when designing turns.  

i. Using this photography method the flight will go much faster than the old 
circling method and in test flight with the Cessna 206 flight speed was up to 
about 180mph agl. Prepare for longer reaction times when turning. 

ii. When 2 locations are very close together (within a mile or two) it is often better 
to go over one target, then fly past it a few miles before looping back for the 
other one.  

iii. Since the camera facing out the bottom of the plane the aircraft must be 
perfectly level in flight to take a good picture.  

iv. If you design too sharp of a turn the plane will have to bank hard to make the 
turn and may not be level in time to take the picture over the target. 

e. You may want more than one flight path or involve an airport stop location in your 
flight plan for fuel if you will be flying for extended time periods.  

f. Again remember your flight time using this method will drastically decrease (by 2X or 
more) compared to circling around each target so don’t underestimate what you can get 
done in a day. It is better to plan more than what you think you can get done it a day 
than not enough so you can best utilize your time with the pilot.  

g. Double check when done drawing that you did not miss any points. 
6. Once the flight path is made stop editing and save your edits 
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7. Make any changes to the rest of your map. Since you are flying to GPS locations you no longer 
need as many landmarks to orient yourself on the map and may want to include less detail and 
clutter on your map such as farmsteads and other buildings or ponds, lakes, rivers and streams 
All those are optional and is up to the preferences of the navigator/photographer. 

8. Once the map is the way you want it zoom so the whole flight path is in your view and you can 
export your map to ArcPad the same way you did for the first flights. 

9. If you do not plan on collecting any new information during this flight that you will need to 
check back in you can just make one checkout session that you can copy to all the laptops in 
the plane (Photographer, Pilot and Navigator/Note taker if needed) 

10. Copy the folder you exported to a USB flash drive, CD or DVD to transfer to the plane. 
Remember to give the pilot a copy of the map to put on their laptop or PDA so they can follow 
the flight path you set for them. 
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Canon EOS 5D Camera Basics 
 

1. Camera Specs: 
a. 12.8 Megapixels 
b. Full frame (35mm) sensor 
c. 3 frames per second shooting speed. 
d. Over $3,000 replacement cost for camera body alone so please be gentle! 

2. Lens Specs 
a. Canon 14mm, F2.8 super wide angle lens with Ultrasonic (for high speed) auto focus) 
b. Canon 28-105mm, F3.5-4.5 zoom lens with Ultrasonic auto focus and UV Haze filter.  

3. The following is from the Canon user Manual. See the manual found with the photo gear for 
more information or download it from the canon website. 
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Webcam Basics 
 
The webcam used is a Logitech Quickcam and is the same type you may use on your personal 

computer. This webcam has been mounted to an eyepiece that fits on the camera to enable a live 
preview through the viewfinder since that is not an option built into SLR cameras. There have been a 
few modifications. 

1. To open the webcam, click the Logitech QuickCam icon on the desktop or on the start menu. 

                           
2. The Logitech toolbar will appear. To open the camera window click on the top icon called 

QuickCapture.  
3. If you want a larger view of the video window you can increase the size where it is labeled 

“Select Image Size” However the 320X240 is a convenient size to allow you to still fit the 
ArcPad window and Canon Remote capture window on your screen. 

 
4. The view area of the webcam is much greater than the view through the viewfinder of the 

camera so the webcam is set to zoom in so all you see in the webcam window is the viewfinder 
instead of the viewfinder with a bunch of black all around. If it is not set to properly zoom in 

and crop out the black area around the viewfinder click on the Settings button  on the 
Logitech toolbar. You can adjust the Zoom or the Pan and Tilt to crop out as much black area 
on the screen as possible and center your image 
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5. The webcam has an auto exposure setting that will automatically adjust the white balance or 

exposure as lighting conditions change. Because about half of what the webcam sees is black 
(even though that is not what you see because you zoom the webcam in to crop out the black) 
the exposure is often over corrected and results in a washed out or very bright image that is 
hard to see. You can manually adjust the exposure. You should do this at the beginning of 
your flight before you reach your first target. 

a. To do a manual adjustment click on the Settings icon  
b. On the Webcam Settings window Uncheck the “Auto” box next to the White Balance 

(seen above). 
c. Click on the advanced Settings Button (Owl icon) 
d. Uncheck the box labeled “Use Automatic Settings” 
e. Move the Exposure until you find the appropriate setting that looks the best in your web 

cam window.  

 



 35

Performing Photography Flights 
 
1. If you will be conducting a short flight and the laptop battery is full you don’t have to plug it in. 

A fully charged battery should last at least 3 to 4 hours. However if you are doing a longer 
flight plug the laptop in using the provided power cord and the power inverter in the plane. The 
screen will be brighter and computer performance will be a little faster when plugged in. 
Caution: DO NOT leave the power inverter plugged in or running if the plane’s engine is not 
running. Aircraft batteries are light duty and will easily die without the alternator recharging it.  

2. Make sure you have a flight map prepared as described above, in which flight paths connecting 
all photo locations are defined. Also provide a digital copy of the flight map to the pilot which 
they will use to guide the plane along the flight path. 

3. Load all flight maps onto the needed tablet laptops in the plane. 
4. Make sure the wide angle 14mm lens is installed on the camera and remove the lens cover 

(Make sure the lens is fully locked on, we don’t need to send an $1,800 lens flying at 2,000 
feet) 

5. Attach the web cam to the eyepiece of the camera 

 
6. Make sure a fully charged batter is in the camera  
7. If you will be storing the images on the camera instead of the laptop hard drive: 

a. Make sure a blank CF card (preferably the 2 gig card) is installed in the camera 
b. Plug the remote cable release into the port located on the left side of the camera under 

the rubber covers. 

 



 36

c. You will not have to plug the camera itself into the laptop or open the remote shutter 
release program on the laptop as will be described below for taking pictures from the 
laptop. 

d. You will still need to use the webcam from the laptop to view throught the viewfinder. 
8. The pilot will have to gain access to the camera port hole before the camera can be installed. 

a. In the Cessna 206 it is located under the second row pilot’s side seat The seat can be 
removed or just slide it all the way forward. An alternative hole can be found farther 
back in the luggage compartment. The camera will not be physically accessible during 
the flight when using this hole so it should be used if the second row pilots-side seat 
will be occupied by an observer.  

b. In the Cessna 182 it is located under the second row seat. Because of this plane’s 
configuration The rear seat will need to be removed for belly mount photography, thus 
only the pilot and one observer will be in the plane. If more observers are needed you 
will need to revert to oblique photography. 

9. Place the camera on the camera mount. 
a. Make sure the camera lens is as straight as possible (perpendicular to the ground) 
b. Make sure the bolt that holds the camera on is tight so the camera will not move 

 
10. Plug in the USB/mini USB data cord, connecting the camera (port under the rubber cover on 

the left side of the camera) to the laptop 
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11. Plug the webcam USB cord into the laptop 
12. Turn on the webcam from the laptop by hitting the Logitech quick cam icon on the desktop, 

then hit the Quick capture button to open the camera window. Make any needed changes to 
webcam settings as described in the Webcam Basics section. 

                                          
13. Place the camera mount over the hole with the camera as straight as possible. When moving the 

camera mount, handle it by the metal or wood frame. Do NOT move it by pulling on the 
camera, webcam or cords! 

14. Turn the power switch on the camera to ON and turn the setting dial to full auto (the green 
rectangle) unless you need specific camera settings and understand shutter speed, aperture and 
ISO settings. 

15. Lower the camera down into the port hole by loosening the adjustment screws on the sliding 
bar. Position the camera so the lens is barely inside the hole. (Use the webcam to see through 
the viewfinder to make sure the edges of the hole are not seen in the viewfinder. 

16. Make sure the adjustment screws are tight. (Do not over tighten and strip the screws!) 
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17. Put the camera neck strap over the metal frame of the mount and make sure any slack in the 

strap or USB cords are not dangling in the hole or tangled where they will be pulled on or 
pinched. 

18. To start the camera remote shutter release option on the laptop: 
a. The tablet laptop must be in landscape display mode for the photography program so if 

the windows screen is screen is portrait (taller than wide) press the rotate button on the 
corner of the tablet screen to rotate it to landscape.  

b. On the desktop of the computer right click (hold the button on the pen down and tap the 
screen if in tablet mode) and choose New>Folder, and name the folder something like 
Photos-Date (Photos-11-2-2006) or something intuitive for future record keeping.  

c. Open the “Zoom Browser” program icon on the desktop. 
d. Choose “Acquire & Camera Settings” 
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e. Choose “Remote Shooting” and click the “Starts Remote Shooting” Icon 

 
f. You will be prompted where to save the photos. Choose the location of the folder you 

just created.  
g. The remote shooting window should appear and show the settings for the camera. The 

blue camera button is the button you will press to take a picture. You may want to test 
this function before you leave the ground.  

 
19. Turn on the GPS units and connect to it using Bluetooth as you did in the first flights described 

above 
20. Open your flight map and initiate the GPS as you had in the first flight map described above. 
21. You should have three programs open on your computer now (ArcPad for navigation, Logitech 

QuickCapture for viewing the webcam, and EOS 5D Remote Capture for taking pictures). 
There may be a few associated programs up as well including ZoomBrowser and the Logitech 
toolbar but they can be left in the background. You may also have windows journal open in the 
background if you need it for taking notes. Arrange your screen so all three important programs 
can be seen at the same time as is seen in this example: 
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22. The pilot should follow the flight line laid out. Be sure to communicate when a photo target is 

approaching to be sure you are heading in a cardinal direction and the plane is as level as 
possible. The pilot should not alter their course during the photography of a point. 

23. To determine the height you need to fly you can use the Photo Scale Estimation Calculator 
Excel spreadsheet provided on the desktop of the laptop or download from 
http://www.fws.gov/devilslake/Flights . To capture a quarter section (recommended) an 
average altitude above ground is 1,800-2,000 ft. It is recommended you provide some overlap 
in your target area (1/4 section plus some).  

24. Monitor your GPS position in ArcPad and check features such as roads or section lines in the 
webcam window as you pass over them to determine the correlation between the GPS position 
and what is seen in the camera viewfinder. Normally the center of the webcam should be very 
close to the GPS position.  

25. When you come upon a point, monitor the webcam window as you get close to the quarter 
section you want to photograph to see when the quarter section comes into view.  

26. When the quarter section is in view hit the remote shutter release button on the laptop to take 
the picture. You may want to take multiple pictures starting just as the desired location is 
coming into view and continuing until it is leaving the view. Since it is all digital it does not 
hurt to have extra pictures but you may regret it if you do not capture the area you needed. If 
you are not using the remote shutter release program on the laptop then press the shutter release 
on the cable release connected to the camera.  

27. Notify the pilot when you have completed taking the pictures of that location so they can alter 
their course to the next location.  

28. Proceed to photograph all points in your flight map.  
29. If you are flying in windy conditions the plane may “Crab” which means the plane will fly 

slightly at an angle from the true direction of travel. If this is the case or the approach angel for 
a target is not quite in a cardinal direction you can correct by slightly turning the camera mount 
in the hole to compensate for the angle. Remember to turn the mount using the metal or wood 
frame and not pull on the camera or cords. 
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30. Depending on the lighting conditions the web cam may need to be adjusted. If the image seems 
washed out, follow the direction above in the Webcam Basics section to adjust the brightness, 
exposure or contrast. 

31. Periodically or if the images seem a little blurry or smudged, check the camera lens. The 
exhaust from the plane is released near the camera port hole and oil can get splattered on the 
lens. If there is anything on the lens, wipe it off with a clean soft cloth or tissue.  

32. The camera may turn itself off to save power if left alone for awhile without any action. It 
should turn back on when the shutter button is pressed halfway or flip the power switch off 
then back on. If the camera is connected to the laptop it will not normally go into power save 
mode but if it does you can turn it back on by pressing the shutter release button or turning the 
camera on and off.  

33. During long flights, occasionally check the power level of the battery on the LCD display on 
the top of the camera. If the battery is getting low, replace it with a fully charged battery. Do 
not wait until it goes dead or it may happen while you are flying over a target. There should be 
3 batteries for the unit. 

34. If you do not have the camera connected to the laptop and thus are storing pictures directly on 
the CF card, check the LCD display on the top of the camera periodically to see when the card 
is full. The LCD will count down the number of pictures remaining. On the 2gig card you 
should get approximately 350 photos. On the spare 1gig card you will get about half as many. 
If you run out of space switch with the spare card in the camera case or download the pictures 
to the laptop using the CF card reader provided in the camera case then put the card back in the 
camera and reformat it (see the Using the Camera section).  

35. When finished with all photos, transfer all images to the laptop using the CF card reader if you 
took any directly on the camera. Use a USB jump drive or a blank CD or DVD (Use NERO 
Burner Smart Start on the desktop and choose data disk) to transfer the images from the plane 
back to the office.  

36. If you collected any new information on your map you can transfer that as well or if not then 
the map can be deleted from the computer 

37. Be courteous to the next user and or the pilot by: 
a. Delete any maps, journal or note files, photographs or any other data you put on any of 

the laptop computers after you have saved it to your own disk and remove all disks from 
the drive. 

b. Return the stylus pen to the port in the front side of the laptop. 
c. Wipe any grease or smudges from the tablet screen using the blue cloth provided in the 

laptop case. 
d. Shutdown the laptops and turn the screen so the writing side is facing down 
e. Inform the pilot of any batteries that need to be charged such as used camera batteries or 

if you ran the laptop on battery power. 
f. Delete anything on the CF card of the camera and leave the 2gig card and a full battery 

(if available) in the camera. 
g. Make sure the lens cap is on and the power is off on the camera. 
h. Put the equipment away in their appropriate places. Laptops have their own carrying 

cases in which the laptop, its cords and one GPS unit with power cord all go in the 
laptop case. The camera and it’s associated equipment go in the pelican carrying case. 
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Combining Observation and  
Photography Flights 

 
 For smaller flight areas or areas with very few violations it is often not worth the time to 
separate flights into two parts (observation and photography). If this is the case: 
 

1. Follow the directions above for creating and using your flight map.  
2. Set up the photography equipment in the plane as was as described above with some 

modifications to the positioning.  
a. If dealing with two observers in the Cessna 206 the preferred camera port is located 

under the second row pilots side seat, thus that seat must be removed or slid all the way 
forward so an observer can not use that seat.  

b. To still observer out the left side of the plane either the left observer has to sit in the 
third row seat with the camera in front of them (which the space is fine but the back 
window gets smaller to see out of) OR 

c. Leave the second row seats intact and remove the third row seats to access the camera 
port near the rear of the plane. You will have to use the USB extension cables provided 
to connect the camera and webcam to the laptop and make sure the battery is fully 
charged on the camera because the camera will be difficult to access in flight.  

3. Once you mark a violation, fly past the location by about two miles before turning around (far 
enough to make a U turn and straighten back out) and make a pass over your target, taking 
pictures as described above in the Photography Flight section. 

4. Then U turn again to get back on the original flight course. 
5. Altitude for photographing a quarter section with some overlap is the same as the altitude for 

easement observations (about 1,000-1,500 ft above ground) 
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Taking Oblique Photos 
 

 Oblique photos are those images taken out the window of the airplane, closer to parallel with 
the ground. This type of photography may be useful when you are trying to capture a landscape view. 
However for easement violations it is highly recommended to use the belly mount or vertical 
photography for several reasons: 

1. Minimal distortion so objects and land features are proportional 
2. Vertical images can be imported into GIS and georeferenced to be used in mapping or 

measurement. 
3. Better resolution and less atmospheric haze because the distance between lens and ground is 

minimized 
4. No glare on the lens from the sun or reflections on the window. 
5. Can be taken with one flight over target, reducing observer fatigue and airsickness caused by 

circling around the target.  
6. Easy to orient the photo (N, S, E, W) and compare to other aerial photography such as FSA. 
 
If you do take oblique photos: 
1. Create your flight map and flight lines as needed as described above to navigate to the 

locations.  
2. You will not use the camera mount or connect the camera to the computer for this type of 

photography. 
3. Make sure a blank Compact Flash (CF) card is in the camera because unlike the belly mount 

photography the images will be stored in the camera instead of on the computer hard drive.  
4. Use the zoom lens (28-105mm) provided with the camera instead of the wide angle (14mm). 
5. Unless you need a specific setting for your application the auto mode should work fine. Turn 

the setting knob on the top left of the camera body to the green square for full auto. 
6. Use your flight map as needed as described above. Circle your target and take photos out the 

window of the airplane. 
7. Make sure to record direction of photography and attempt to get distinguishing landmarks in 

the frame to use for orientation. 
8. Do not touch the camera or lens to the window as the vibration will transfer to the camera and 

blur your image. 
9. When finished use the CF card reader to transfer the photos to the laptop where they can then 

be saved to a USB flash drive, a CD, or a DVD. 
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Low Distortion or Special Use  
Aerial Photography 

 
 The super wide angle lens used for easement flights was chosen because you will be able to fly 
relatively low (<2,000 feet) and still capture a ¼ section or more. This low altitude is convenient for 
several reasons: 

1. Easement flights often conducted in fall or spring often coincided with sporadic weather and 
low clouds. Lower flights allow you to fly under a lot of cloud cover and still be able to take 
pictures 

2. Lower flights provide more clear images due to less atmospheric haze to shoot through 
3. Many stations combine observation and photography flights into one flight and the altitude 

used for observation flights is conveniently about he same as that used for photography with 
the wide angle lens. 

4. Lower flights allow observers to see their targets easier. 
 

Conventional aerial photography uses a less wide lens due mainly to distortion issues. Wide angle 
lenses often produce distortion around the edges of the image that will make straight lines appear 
curved (often referred to as the fish-eye effect). The 14mm lens uses with the airplane is one of the 
highest quality wide angle lenses available on the consumer market and therefore has corrected for the 
distortion as much as possible. However some distortion is still present. Another issue you may notice 
is less light is gathered around the edges of the lens so in some cases you will see a darkening as you 
get away from the center of the image (minimal in test runs with this lens). 

 
If you have a need for very high quality aerial photography that has as little or no distortion as 

possible and has even lighting, these are a few options you may consider. 
1. Fly using the standard methods described above but leave plenty of overlap so the target or 

important part of the image is in the center of the frame. 
2. Switch to the zoom lens and set it to 50mm or greater. 

a. A higher mm lens will produce a better image. However you will have to consider that 
the altitude you fly will be much greater.  

b. Example: To photograph approximately a ¼ section you need 1,800 feet with a 14mm 
lens and over 6,000 feet with a 50mm lens. 

c. The higher the altitude the more you will have to deal with low level clouds, 
atmospheric haze and oxygen above 10,000-12,000 feet. 

d. When the zoom lens is faced downward the weight of the lens elements may cause the 
zoom ring on the lens to rotate and drop which works the zoom mechanism.  

i. To counter act this your may need to set the lens to 50mm (or other setting for 
your needs) and use masking tape or electrical tape to hold the zoom ring in 
place.  

ii. Do not use duck tape or other tape that will leave a sticky residue on the lens 
and may damage the lens. 

iii. Do not place the tape over the focus ring or your pictures may not be in focus.  
3. If you will be conducting a lot of low distortion aerial photography you may consider 

submitting a proposal to purchase a fixed 50mm lens for the current camera equipment.  
a. A fixed lens as opposed to the zoom lens currently provided for the camera will provide 

better quality and more consistency.  
b. Canon EF compatible lens is required to work with this equipment.  
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4. Other camera settings that will improve image quality include 
a. Lower ISO (film speed) provides a better quality image but requires longer shutter 

exposures 
b. Smaller aperture (higher number) makes a greater depth of field so more of the subject 

is in focus but the smaller the aperture the less light and the slower the shutter speed. 
Depth of field is not a big issue in relatively flat terrain. 

c. Any time you have a slower shutter speed (long exposure) you have to be careful about 
image blur due to movement. If objects in the frame move perceptibly (more than the 
length of one pixel) in the time the shutter opens and closes it will appear as a blur. A 
standard rule for handheld photography is the shutter speed (in tenth’s of a second) must 
be higher than the lens focal length (measured in mm); so a 14mm lens must have a 
shutter speed of greater than 1/14 of a second. However with the fast movement and 
vibrations in and airplane it is suggested to not go under 1/60th of a second and use even 
faster minimums if using the zoom lens.  

d. Shooting RAW format instead of the standard JPG high quality. Using the RAW mode 
you have no image compression and no quality loss but you must post process each 
image (like a digital darkroom) which takes a lot of time and Photoshop skill.  

5. Another option to remove distortion form your images is use the current equipment but import 
the image into ArcGIS and georeference it against an orthorectified images such as the FSA 
county mosaics. You will need as many points as possible spread out throughout the image and 
choose 2nd or 3rd order polynomial correction. This will warp the image to remove distortion. 
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Post Processing Your Photos if Needed 
 

Post process is not necessary but may improve some images. The most changes needed will be in 
brightness and contrast. Adobe Photoshop is the program of choice for enhancing your images 
although there are other programs on the market that can do well also. Almost any version of 
Photoshop have some of the basic options. For more advanced tasks such as batch processing you may 
need more than a Photoshop elements version. This tutorial is based off of Photoshop CS. 
 

Original 

 
 

Enhanced 
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1. If you are only modifying a few images you can do each one individually.  
a. Open Adobe Photoshop and then open the image(s) you want.  
b. Under the Image>Adjustments menu choose Auto Levels or use the shortcut key 

Shift+Ctrl+L. Most often this will be all the adjustment you need and automatically 
balances contrast, brightness and white balance.  

c. For more precise control over brightness and contrast choose the Levels option (Ctrl+L) 
from the Image>Adjustments menu. You will see a histogram of the image with three 
sliding arrows at the bottom. Adjusting the outer two arrows adjusts the light and dark 
contrast. Adjusting the center arrow changes the brightness.  

d. The Hue/Saturation tool can be chosen from the Image>Adjustments menu or use 
Ctrl+U. In this menu all you really may want to adjust is Saturation which will boost the 
intensity of the color to help bring out some features. This can easily be overdone so do 
not adjust more than 10 or 15 points. 

e. The shadow/highlight tool is also available on the adjustments menu and can be used to 
only brighten dark areas or darken light areas. This may be helpful if you have shadowy 
images. 

f. The last tool you may want to use is the Sharpen tool found under the filter menu. This 
tool sharpens lines and edges of objects in the image and may make some features stand 
out more. Using the standard “Sharpen” command will automatically sharpen. If you 
want to have some control over the sharpening intensity use the “Unsharp Mask” 
Option. 

 
2. If you are dealing with many photos you may want to create a batch process. 

a. First you have to create a set of actions. 
b. Open a single photo you want to use as the test run for your processing. 
c. Select “Actions” from the “Window” menu 
d. At the bottom of the actions window click on the folder icon to create a folder to store 

your batch process in and name it something like Batch Process. 
e. Once the folder is created click on the “Create New Action” button. Give the set of 

actions (batch process) a name such as Air Photo Enhance, and under “Set” choose the 
folder you created. When done hit “Record”. 

f. Do whatever image processing you want on the photo and the program will record those 
actions so you can later apply the same process to all images.  

g. For example a standard simple processing action would be: Once you start recording. 
Choose Auto Levels from the Image>Adjustments menu, then use the Hue/Saturation 
option and increase the Saturation to 12, then use the Shadow/Highlight tool and set the 
Shadows level to 13. 

h. When done with the actions you want hit the Red Stop square icon at the bottom of the 
Actions window.  

i. Close but don’t save the sample photo you had open. If you save it then run it as part of 
the batch process it will be processed twice. 

j. To run a batch process choose File>Automate>Batch 
k. Under Set choose the folder you created and from the Action List choose the action you 

created. 
l. Under the Source set it to folder and click on the Choose button to choose the folder 

that all your photos are stored in. The process will go through all the photos in the 
folder and it can also look in subfolders if you check the “Include All Subfolders” box. 
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m. Under Destination choose “Save and Close” if you want to just enhance and overwrite 
the original files or you can choose to save the enhanced version to a different folder by 
choosing the “Folder” option. 

n. Hit OK when done and the Batch process will run 
o. In some cases (especially if it is the first time the jpg image has been modified and 

saved) the process may stop each time it needs to save the image and ask what quality 
to save at. This is a little annoying and would be nice if the same quality could be 
chosen for all but a solution has not been found yet. Just choose maximum quality each 
time or if it is already set to maximum just hit the enter key each time the window pops 
up. 

 
3. To preserve data integrity, especially since many of the photographs taken represent possible 

evidence in legal investigations it is recommended you keep an original unaltered version of the 
photograph in case the integrity of any enhancements to the image ever come into question. For 
that reason it is also discouraged that you use any other tools other that those that simply 
enhance the histogram of the image. Tools that alter the pixels such as brushes, pens, patch or 
eraser tools should not be used.  

4. Also keep in mind that each time you save a “Lossey Compression” image such as a JPG 
format image it will re-compress the image and you will loose some quality. For this reason it 
is recommended you do all post processing you will need in one session instead of doing an 
adjustment and then resaving multiple times. Alternatively you can save the image into a RAW 
or Lossless format such as a TIFF file in which there is no compression or quality loss but the 
file size is larger. Just opening a image to view will not result in loss of quality. Only resaving 
in a compressed format will reduce the quality. 
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Troubleshooting Data Check In 
 
 When you checkout your data to ArcPad, ArcGIS maintains a record of that checkout and 
stores it with the map document (*.mxd). Therefore when you want to check the data back in and have 
it merge any new changes back into the original file it must refer to the record of the checkout. Once 
the data has been checked back in the record of the checkout is automatically erased.  
 
Common problems with data check in include: 

1. The check in option only is available if you are in editing mode for one of the geodatabase files 
in the dataset. If the check in option is not highlighted start editing the geodatabase layer such 
as the violations layer and the check in button should be highlighted. 

2. The map was not saved after the checkout therefore no record of the checkout was saved. 
3. Only files that come from a geodatabase (feature classes) can have data merged back into the 

original dataset, so if you checked out a shapefile, don’t expect to be able to check it back in.  
4. During the checkout process you were first asked which files you want to export, then you were 

asked, of those files, which of the geodatabase files do you want to be able to check back in? If 
you did not check off those files at that time they will not be checked back in. 

5. There is an option on the ArcPad toolbar in ArcMap to delete records of a checkout. If the 
record was deleted it can not be retrieved. 

6. A data set to be checked out was not given a unique name. If two checkouts where done with 
the same name there is only 1 record of a checkout with that name so you can check in one of 
the datasets but the second one won’t check in.  

7. The changed data (set of data you collected while in the plane) must be placed back in the exact 
original location on the computer where it was put when you checked out the data. You must 
overwrite the original copy of the data with the changed copy. 

8. If you had 2 records of checked out data (Example: Laptop1 & Laptop2) and you only brought 
back Laptop1 data from the plane and went to check it in but during the check in you chose to 
check in the data from both Laptop1 and Laptop2. It will check in both sets of data and erase 
the record of the checkouts. Therefore when later the Laptop2 data comes back from the plane 
and you attempt to check it in it will fail because there is no record of the checkout.  

 
Solutions 

1. The easiest way to check in data when a record of the checkout is lost or missing is to create a 
false checkout. 

a. For this example we will call the data set that you what to check in but can’t the 
“GoldenData” 

b. In ArcGIS open your original map and perform a checkout with all the data that is in the 
“GoldenData” set. 

c. During this new checkout make sure you check the boxes when asked which of the 
geodatabase layers you want to be able to check back in (2nd window during checkout). 

d. Choose a location to store this checkout such as your desktop and name it 
“FalseCheckout” 

e. Save your map in ArcGIS 
f. Using Windows Explorer or the My Computer window open the “GoldenData” folder 

and copy all the files in the folder. 
g. Past the “GoldenData” files into the “FalseCheckout” folder and overwrite any files in 

that folder.  
h. Return to ArcMap and your saved map. 
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i. Start editing one of the geodatabase layers such as the violations layer. 
j. The ArcPad check in button should appear highlighted. Hit that button. 
k. Choose the FalseCheckout data to check back in and continue with the check in.  
l. Save the edits and stop editing. 
m. Your data should now be checked back in and you can delete both the GoldenData 

folder and the FalseCheckout folder 
2. If the above method does not work or you are trying to check in data such a shapefile or newly 

created data layers that were not part of the original checkout you can append or merge the data 
from the checkout data to the original data. However using this method it will not recognize 
new versus old data so if you have features that appear in both the checkout and original 
datasets then in the merged output there will be 2 points instead of one for each overlapping 
feature. 

a. Open either ArcMap or ArcCatalog and open the ArcToolbox window  
b. Under Data Management Tools>General choose Append or Merge 

i. Append will combine data from one or more data layers and put it into an 
EXISTING layer that you specify. Using Append you must choose the “No 
Test” option if the attribute tables of the two files do not have the same exact 
fields. Also notice if they don’t have the same fields the non-matching fields 
won’t import into the exiting layer. You will transfer the points but may loose 
the attributes. 

ii. Merge will combine two or more data layers and put it into a NEW layer that 
you specify. The attributes from all input files will be merged into the output so 
you don’t have to worry about matching fields. 

3. One final option for getting checkout data back into the original geodatabase is to open 
ArcCatalog and navigate to the geodatabase that contains your data. Right click on the feature 
class that you want to put data back into such as the points layer. Choose the “Load Data” 
option and follow the on-screen wizard. 
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Legend for Flight Map 
 
 Below is the general legend for the pre-made flight map if you choose to use it. There may be 
some slight variations if you have made any changes to the data. For consistency as well as to assist the 
pilots that may be using maps you provide them it would be helpful is general color and symbol 
schemes remain the same or similar even if you design your own maps.  
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Photographic Examples: 
 

These images were taken with the photographic equipment supplied with the plane. They were 
then imported into ArcMap and georeferenced so scale could be compared. The images were from an 
easement restoration project. The red line is one square mile. 

 
Photo Scale Comparison: 
 
1 square mile taken at 3,500ft AGL    ¼ section taken at 1,900ft AGL 

  
 
¼ section wide taken at 1,300ft AGL    Low Level taken at 500ft AGL 
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Resolution Comparison: 
 

  

  

 

2005 FSA Imagery 1m Resolution 3,500FT AGL – 26.2 Inch Resolution 

1,300FT AGL – 8.5 Inch Resolution 1,900FT AGL – 13.7 Inch Resolution 

500FT AGL – 2.6 Inch Resolution 
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Quick Start Checklist 
At your Office 

1. Prepare your flight map in ArcMap and save the map. 
2. Export the flight map using the ArcPad Checkout feature (Export once for each laptop/observer you will 

use). 
3. Copy the exported folder to a CD or a USB flash drive 

In the Plane 
1. Take out the laptop you will use and place the GPS in the dash of the plane and turn on the GPS. 
2. Copy the Flight Map from the CD or USB flash drive to the desktop of the computer 
3. Connect to the GPS using the “My Bluetooth Places”  
4. Open ArcPad and hit the folder icon to open the map you just copied onto the laptop. 
5. In ArcPad activate the GPS (Click on the GPS/satellite icon) 
6. Setup your GPS Tracklog if desired (Located in the layers menu, double click on the track log, place the 

location in the flightmap folder you created, give it a name, select an interval) 
7. Zoom to your desired scale using the zoom tools. 
8. Turn on the Automatic Map Rotation (Hit the Map rotation button on the oversized toolbar, default 

values will be fine, hit ok to start rotation) 
9. Start editing your violations layer (Hit the drop down arrow next to the pencil icon and choose 

violations layer). 
10. Mark violations on screen as you see them (use the point button on the oversized toolbar and tap on the 

screen to place a point, choose from the drop down list to select a violation type and hit OK to place the 
point). 

11. Close Arcpad and copy the Flight map folder from the computer back to the USB flash drive or burn a 
CD or DVD. 

Back at the Office 
1. Copy the flight map folder from the USB flash drive or disk back to the original location, overwriting 

the original files. 
2. Open the original flightmap you had checked out data from in ArcMap 
3. Start editing the violations layer 
4. Use the ArcPad check in button to check in the contents of the folder you had collected your data from. 
5. Once checked in save the edits and save your map 
6. Repeat for all data checked out (each laptop/observer) 

Photography Flights 
1. Prepare your flight map as you had done before but include a flight line connecting all points you wish 

to photograph. 
2. Export the flight map using the ArcPad checkout feature as you had done before and transfer the maps 

to the plane laptop. 
3. Secure the camera in the mount and attach the webcam to the eyepiece. 
4. Position the camera in the belly hole. 
5. Connect USB cords from webcam to laptop and from camera to laptop. 
6. Create a folder on the desktop of the laptop to store your photos in 
7. Start the Bluetooth GPS, ArcPad flight map, GPS Activation in ArcPad, Tracklog, and Map rotation as 

was done before. 
8. Open the Logitech webcam window and adjust exposure if needed. 
9. Open the Zoombrowser application and start the remote shooting option. 
10. Position the windows so ArcPad, Webcam viewer and remote shooting tool are all visible on the screen. 
11. The pilot must follow the flight lines and when you fly over the target confirm the target location by 

using the GPS position and what you see in the webcam window, then hit the remote capture button to 
take photographs.  

12. When finished, transfer the folder containing the photos to a USB flash drive or a CD or DVD to 
transfer back to your office. 


